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Register for Wireless:  
 1. Start up your computer: Wireless DHCP Service: Turn on your device. (For 

laptops, make sure the wireless card is enabled.)  

Please Note: You will need to do the same steps for Wired DHCP Service: First 
Connect your laptop to an ethernet drop and turn it on, then follow the same steps 
listed below.  

 2. Start up your web browser. Result: The Welcome page displays: 

 

 
 

  

  

  

  

  

  

  

  



 3. Click on your status type. Result: The following page displays:  

 

 4. Read the instructions, then click Register. Result: The following page displays:  

 
 



 5. Fill in the requested information, then click Register. Result: The Registration 
successfully completed page displays.  

 

 
 
It will take approximately 15 minutes for the process to complete. Make sure you clear 
out your browser cache before attempting to connect via DHCP.  
Internet Explorer 7: Tools>Internet Options>General. For Browsing History click 
Delete, then for Temporary Internet Files, click Delete Files  
Please test your connection by visiting both an internal web site, e.g., web.mit.edu and 
an external site, e.g., www.boston.com.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Internet Explorer 7.0 MIT Certificate VBScript Error Fix  
 

1. Open windows Explorer; Right click on Start and choose Explore:  
 

 
 
Result: Windows Explorer opens 
 

 
 

2. Click on Tools and choose Folder Options from the drop down menu:  
 

 



Result: The Folder Options window opens  
 

 
 

3. Go to the View tab and in the Advanced Settings section check the radio button for  
“show hidden files and folders”  

4. In the same section uncheck the box for “hide protected operating system files  
(recommended)”  
 

 
 

5. Answer ‘Yes’ when you receive the Warning message:  
 



 
6. Scroll all the way down to the bottom of Advanced Settings section and uncheck the  

box for “Use Simple File Sharing(Recommended)”.  
 
 

 
 

7. Click Apply to save the changes and OK to close the Folder Options window.  
8. In the main Windows Explorer expand the folder list and browse to the folder  

C:\Documents and Settings\username\Application Data\Microsoft\Crypto\RSA  
(where username needs to be replaced with the actual Windows username)  
 



 
 
 

9. Right click on the RSA folder and choose ‘sharing and security’ from the drop down  
menu  
 

 
 
Result: The properties window will open. 
 



 
 

10. Go to the security tab and click on ‘Advanced’.  
 

 
 
Result: the Advanced Security settings window opens: 
 



 
 

11. Check the box “Replace permission entries on all objects with entries shown here that  
apply to child objects”.  

12. Click Apply to save the changes and OK to close the Advanced Security Settings  
window  

13. Close all Windows Explorer windows and go back to Internet Explorer to obtain a  
personal certificate.  
 
 



Internet Explorer 7 for Windows XP: 
Obtaining MIT Certificates 
 

Overview 
In order to use secure web services at MIT, you will need to obtain two types of MIT web 
certificates: 

• MIT Certificate Authority (MIT CA)  
• MIT Personal Certificate  

This page provides instructions for installing both types of certificates in IE7 on Windows XP. 

Note: If you are upgrading from IE6, your existing MIT certificates will be carried over into IE7.  

 

Get the MIT CA (MIT Certificate Authority)  

 
The MIT Certifying Authority (CA) certificate is used to confirm that the Web servers you are 
connecting to are valid MIT servers. Complete the following steps to obtain your CA certificate for 
Microsoft Internet Explorer:  

1. In IE7 go to Certificates at MIT. 
Result: The Certificates at MIT page appears. 

2. Click Get MIT CA (Certificate Authority). 
Result: The File Download dialog appears. 
 

 

3. In the File Download window, click Open. 
Result: The Certificate dialog appears with an "X" over the Certificate Information icon 
indicating that the certificate has not yet been installed. 



 

 

Note: If the above Certificate screen does not appear, see Importing the CA 
Certificate into Internet Explorer  
http://itinfo.mit.edu/article.php?id=6725 and follow the instructions 
provided.  

4. Click Install Certificate. 
Result: The Certificate Import Wizard dialog appears. 
 

 

5. Click Next. 
Result: The second dialog of the Certificate Import Wizard appears. 



 

 

6. Leave the default setting to "Automatically select the certificate store based on the type 
of certificate" and click Next. 
Result: The third and final dialog of the Certificate Import Wizard appears. 
 

 

7. Click Finish. 
Result: The Root Certificate Store dialog appears and asks the question: Do you want to 
ADD the following certificate to the Root Store? 



 

 

8. Click Yes.  
Result: A dialog appears indicating the Certificate Import was successful. 
 

 

9. Click OK and then click OK again to close the certificate dialog. 
Result: The MIT CA certificate has been installed.  

 

Get the MIT Personal Certificate  
The first time you try to get a new MIT personal certificate in IE7, you will encounter a security-
related action, Certificate Enrollment Control, which did not occur in previous versions of IE. This 
action is related to authenticating web-browser add-ons, and is part of the Windows ActiveX 
Control environment. ActiveX enables communication and interaction between software and 
media components which are to be integrated into a web page.  

1. To begin the process of getting a new certificate, go to Certificates at MIT. 
Result: The Certificates at MIT page is displayed. 

2. Click Get MIT Personal Certificate. 
Result: The following page is displayed.  
 



 

 

3. Enter your MIT identification information and click Submit. 
Result: The page Generate a Private Key is displayed. 

4. Click Next. 
Result: The following Information Bar dialog box and web page page are displayed.  

5. In the dialog box click Close. 
 

 
 
 
Attention! On the web page, direct your attention to the information bar near the top 
(indicated here by the large arrow). In previous versions of IE the Certificate Enrollment 
Control has not appeared when getting certificates; it is part of the Windows ActiveX 
Control environment.  
 



 

 

6. To continue the process of getting a certificate, click in the information bar. 
Result: A small pop-up menu will appear. 

7. In the pop-up menu click Run ActiveX Control.  
Result: The following security warning appears. 
 
 

 

8. Click Run.  
Result: You will be returned to the page Get an MIT Certificate.  
 
Note: Because ActiveX Control was run for this instance of getting a personal certificate, 



in the future, the Certificate Enrollment Control warning should not appear when you get 
a new personal certificate with this particular IE7 browser. 

9. Re-enter your information and click Submit. 
Result: The page Generate a Private Key should be displayed. 

10. Click Next. 
Result: The following warning is displayed. 
 
 

 

11. Click Yes. 
Result: The dialog box for creating an exchange key (or browser password) is displayed. 
 
 

 

12. IS&T recommends changing the default security level from Medium to High.  
Click Set Security Level. 
Result: The dialog box for security level is displayed. 
 



 

 

13. Click the radio button for High, then click Next. 
Result: The dialog box to create a browser password is displayed. 
 
 

 

14. Enter and confirm your password, then click Finish. 
Result: You will be returned to the initial exchange key box.  
 
Note: Do not make this the same as your Kerberos password. This password is for your 
MIT certificates on this particular IE7 browser. When you go to a secure web page 
requiring your MIT certificate, you will be prompted to enter this password.  



15. In the exchange key box, click OK. 
Result: The following warning is displayed. 
 
 

 

16. Click Yes. 
Result: The MIT page confirming installation of your new personal certificate should be 
displayed.  

 MIT IS&T Article #8225 

 



Internet Explorer 7 on Windows Vista: 
Obtaining MIT Certificates 
 

Overview 
In order to use secure web services at MIT with IE7 on Windows Vista, three types of MIT web 
certificates are needed: 

• MIT Certification Authority (MIT CA), which confirms that the Web servers to which you 
are connecting are valid MIT servers  

• MIT Client Certificate, needed in IE7 on Vista to generate the personal certificate  
• MIT Personal Certificate, which authenticates you to MIT”s secure servers  

First-Time Installation of Certificates 
If you are installing certificates for the first time in IE7 on a Windows Vista system, either as 
administrator or on an individual user account, you must run the Certificate Installer Tool for 
Windows Vista before getting the personal certificate. 

Users of win.mit.edu 
Users of win.mit.edu are not required to†perform any additional steps over the current IE6 
requirements to obtain†certificates for IE7. This applies to both Windows XP and Vista. 

Note: The MIT Client Certificate is necessary only with IE7 on Vista; it does not apply to IE on 
Windows XP or Firefox, or to other browsers (such as Firefox).  

 

Get the MIT Personal Certificate  
The MIT personal certificate authenticates the user to MIT's secure servers.  
Note: A separate certificate password is not necessary for IE7 on Vista; the certificate is 
protected by your Window user account password.  

1. In IE7 go to Certificates at MIT and click on Get MIT Personal Certificate. 

2. On the page Get an MIT Certificate, under Identify yourself, enter your Kerberos 
username and password, and your MIT identification number. Click Submit. 

3. The Web Access Confirmation window appears, asking if you want to request the 
certificate; click Yes. 

4. The Web Access Confirmation window appears again, asking if you want to add the 
certificate; click Yes. 

5. On the page Generate a Private Key, leave the Key Size at the highest grade for your 
browser. The Certificate Lifetime gives the default number of days until this personal 
certificate expires. Click Next to accept the defaults. 
 
Note: You may set the certificate lifetime to a lower number, especially if you are getting 
a personal certificate on a computer which you will be using only a short amount of time. 
Setting the lifetime to zero (0) means the certificate expires after three hours. 

6. A new page is displayed with confirmation that the certificate is installed. 

 

 

MIT IS&T Article #8307 



Printing at MIT –  
 
Go to Start>Printers and Faxes and the following screen will appear:  
 

 
 
Click on add printer and the following screen will appear:  
 

 
 



Click on next and the following screen will appear:  
Select local printer attached to this computer and remove check from automatically 
detect and install my plug and play printer, see below.  
 

 
 
Then, click on next and the following screen will appear:  
Click on Create a new port. Type of port = Standard TCP/IP Port.  
 

 
 



Click on next and the following screen will appear:  
 

 
 
Click on next and the following screen will appear:  
From the table below, please select the correct IP Address for your location and type it 
in the Printer Name or IP Address box as shown below:  
 

ROOM 
NUMBER  

PRINTER 
NAME  

PRINTER IP 
ADDRESS  

Printer Model  

66-240  PAZ  18.63.4.37  HP Laserjet 4100N  
66-244  BORGES1  18.63.4.36  HP Laserjet 4100N  
66-252  SAAVEDRA  18.63.4.38  HP Laserjet 4100DTN  
66-253  M66253-HP  18.63.4.238  HP Laserjet 4200DTN  
66-253 M66253-HP2 18.63.2.104 HP Laserjet 4100DTN 

 



 
 
Click next and the following screen will appear:  
 
Click finish and the following screen will appear:  
 

 
 
Please refer to the table above for the correct Printer Model.  
Manufacturer = HP, Please select the Postscript Printer Driver (PS) ONLY  
 



 
Printers = HP LaserJet 4100 Series PS for Rooms 240, 244 & 252, Printers PAZ, 
BORGES1 and SAAVEDRA.  
Printers = HP Laserjet 4200 Series PS for Room 253, Printer M66253-HP.  
Go to http://web.mit.edu/cheme/resources/cheme_comp.html to download the postscript 
printer driver for M66253-HP.  
 

 
 
Click on next and the following screen will appear:  
Type in the name of your printer.  
Please refer to the table above for printer names.  
Do you want to use this printer as the default printer, choose yes if it is the primary 
printer. If the printer is used for backup purposes choose no.  
 



 
 
Click on next and the following screen will appear:  
Do you want to print a test page? Choose YES to make sure it is working correctly.  
 

 
 
Click on next and the following screen will appear:  
If the test page printed, click OK. If the test page did not print ok, then delete the printer 
and run thru setup again.  



 

 



If you have already Installed a Printer Port –  
If you have already Installed a Printer Port you cannot do this a second time. If you 
need to reinstall the printer or it did not install correctly you must select “Use the 
following Port”, see below:  
 

 
 
Scroll down until you find the correct port you already installed and click on next. 
Continue installing the printer, please refer to “Printing at MIT”.  
 
If you try to add a port that already exists the following error message will appear, see 
below:  
 

 
 



Duplex Printing – M66253-HP and SAAVEDRA Printers ONLY!  
 
Currently the only 3 printers that have a Duplex Unit, see table below: 
 
Duplex Printer Locations Duplex Printer Name 
66-253 M66253-HP 
66-253 M66253-HP2 
66-252 SAAVEDRA 
 

1. Open Printers and Faxes.  
2. Right-click the printer you want to set options for, and then click Properties.  
3. On the Device Settings tab, double-click or scroll down until you see Installable 

Options and look for Duplex Unit (for 2-Sided Printing) and change the setting 
from not installed to installed.  

See below for screen shot:  
 

 



 

Microsoft Office 2007 Enterprise:  
 
Q: I don't want to remember each time to save my files in the 97-2003 
format. How can I set up Office 2007 so that all the new files will be 
saved automatically in the 97-2003 format?  
 
A: This is not a global setting so you have to do these steps for the three Office 
applications: Word, PowerPoint, and Excel.  
 

 1. In the upper left corner, click on the Office icon.  
 2. Do one of the following:  

 o In Word, click Word Options.  
 o In Excel, click Excel Options.  
 o In PowerPoint, click PowerPoint Options.  

 3. From the left side on the window, click Save.  
 4. Locate the option Save files in this format:, and do one of the following:  

 o In Word, click Word 97-2003 Document (*.doc).  
 o In Excel, click Excel 97-2003 Document (*.xls).  
 o In PowerPoint, click PowerPoint Presentation 97-2003 Document 

(*.ppt).  
 5. Click OK.  

 
Each document saved from this point will automatically be saved in the 97-2003 format. 
Once you save this option for all Office applications, Office will start saving the files you 
create in what is called "Compatibility Mode."  
 
PLEASE NOTE:  
 
The Microsoft Office 2007 Tool will not work with Microsoft Office 2007 Enterprise the 
only way to save files in the 97-2003 format is to do the steps listed above.  
 
There is no converter for MAC Users so you will have to change the format to 97-2003 
every time you send a file to a MAC User, unless you change the default file format.  
 
Also note that no everyone is on Microsoft Office 2007 at this time and there is an Office 
2003 Add-In (Office 2007 Compatibility Pack) so that 2003 users can view Office 2007 
Files. 
 



Applications that need to be installed and setup by you:  
 
Matlab:  
 
matlab.mit.edu or http://web.mit.edu/ist/products/vsls/ and select Matlab and look under 
License Eligibility, then Students, then Student Matlab Experiment Page, this can 
be found at the bottom of the page.  
 
Maple 10:  
 
Maple 10 has been installed on your laptop, but you will need to Activate it, please refer 
to the email pasted below:  
 
Greetings,  
 
Thank-you for visiting Information Services and Technology's (IS&T) download 
site for Maple.  
 
MIT faculty, staff and students are entitled to install this software on MIT 
owned computer(s) and one personally owned machine to be used for educational 
purposes. The right to use this license ends when you leave MIT. Upon leaving 
MIT for any reason, including graduation, you are required to cease use and 
delete it from personally owned computers.  
 
Your right to use the software shall be governed by the most current license 
terms. Updates will be posted at:  
 
https://web.mit.edu/ist/products/vsls/speceng/maple.html  
 
Maple 10 Licensing  
 
To activate your product, you will need the purchase code  
 
KS95B55MFJRNX2YF  
 
To obtain a single user license, you must complete the activation process 
after installing Maple 10. The activation process automatically obtains and 
installs your license file. On Windows and Linux, you can activate during the 
installation process.  
 
If you do not activate during the installation process, follow the steps 
below:  
 
1. Ensure that you can connect to the internet. Activation requires an 
internet connection.  
2. Start Standard Worksheet Maple 10.  
3. When prompted to activate, click Activate.  
4. You will be prompted to enter your purchase code. If you are activating 
through a proxy server, ensure that you enter this information before 
clicking Next.  
5. You will be prompted to enter additional information. When finished, click 
Next.  
 
A Maple 10 license file (license.dat) will be saved in the license folder of 
your Maple 10 installation.  
If you experience difficulties with activation, further instructions are 
available at:  



http://www.maplesoft.com/support/install/Maple10.aspx  
Cordially,  
Information Services and Technology 
 



Helpful Websites to get & keep your laptop running correctly:  
 
 • Microsoft Windows Updates:  
 
http://www.update.microsoft.com/microsoftupdate/v6/default.aspx?ln=en-us or Start>All 
Programs>Windows Update  
 
 • Microsoft Office 2007 Enterprise Updates:  
 
http://office.microsoft.com/en-us/downloads/default.aspx and on the left hand side click 
on Office Update and follow the prompts.  
 
 • Updating VirusScan Enterprise 8.5.0i:  
 
AutoUpdate is scheduled to run by default at 4AM, 11AM, 3PM, and 8PM, if it misses 
one of these times it will run the next time the laptop is turned on.  
 
Scan All Fixed Disks is scheduled to run by default at 5AM, if it misses this time it will 
run the next time the laptop is turned on.  
 
I would not change these settings as these are for the protection of your data.  
 
Adobe Acrobat Professional 8.0:  
 
Open Adobe Acrobat and click on the help menu, then click on Check for Updates… 
 



Helpful Websites at MIT:  
 
Information Services and Technology for the MIT Community: 
 
http://web.mit.edu/ist/ 
 
Athena User Accounts: 
 
http://web.mit.edu/accounts/ 
 
Network/Connectivity at MIT: 
 
http://web.mit.edu/ist/topics/security/ 
 
Certificates at MIT:  
 
http://web.mit.edu/is/topics/certificates/ 
 
Email at MIT:  
 
http://web.mit.edu/ist/topics/email/index.html 
 
MIT Software Download Site:  
 
http://web.mit.edu/software/ 
 
Backup at MIT:  
 
http://web.mit.edu/ist/topics/backup/index.html  
 




